Electrénica Digital — Practica 5 D I

Departamento de Tecnologia Electrénica

Practica S:
Diseiio y realizacion de circuitos secuenciales mediante circuitos
programables (II)

Introduccion

En esta practica se diseflara y simulard un circuito secuencial con subsistemas dentro de un
entorno informatico y ademas se programara para comprobar su funcionalidad mediante el
encendido de displays 7 segmentos. Es esencial que, antes de acudir al laboratorio, el alumno
haya leido atentamente y comprendido toda la parte introductoria de la practica 5.

Objetivos
La practica comprende tres partes:

e Parte 1: Estudio teorico
En esta parte de la practica se plantea el disefio a realizar. Habra de ser realizada por el
alumno antes de acudir al laboratorio.

e Parte 2: Estudio experimental
Consiste en la introduccion, simulacion y programacion del disefio.

NOTA: Esta practica se realizara de manera individual, cada alumno en un ordenador.
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Flujo de disefio con herramientas de CAD

Los pasos a seguir para realizar un disefio con la mayoria de las herramientas informaticas de
disefio electronico (CAD) son muy parecidos, mostrandose de forma grafica en la Figura 1. Estos
pasos son:

En primer lugar, hay que introducir el disefio. En la practica que se plantea este disefio se
realizara mediante un entorno de captura de esquemas, poniendo e interconectando los
simbolos de los distintos componentes mediante un entorno grafico.

En segundo lugar, hay que crear los patrones o estimulos que se le van a introducir al
circuito con objeto de comprobar su funcionamiento.
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Figura 1: Esquema de la realizacion de un disefio mediante herramientas de CAD.

En tercer lugar, se simula el circuito utilizando los patrones creados anteriormente.
Normalmente el propio entorno de disefio asocia internamente el modelo 16gico de cada
celda al entorno de simulacion. De esta forma lo que se tiene es una simulacion funcional,
donde no se tienen en cuenta los retrasos. Con esta simulacion se comprueba que el disefio
realizado tiene la funcionalidad deseada.

Una vez comprobado funcionalmente el disefio se pasa a su implementacion. En este caso
se genera la forma interna en la que habra de programarse el dispositivo para conseguir
la funcionalidad deseada.

Una vez implementado el disefio se realiza la simulacion temporal. Del resultado de la
implementacion y del modelo que tiene la herramienta del dispositivo, se extrae el
comportamiento temporal del dispositivo, de forma que junto con los patrones
anteriormente creados pueda realizarse una simulacion temporal. En esta simulacion,
ademas de comprobar que los retrasos no afectan al comportamiento pueden medirse los
retrasos.

Finalmente, una vez comprobada la funcionalidad, se pasa al ultimo paso: la
programacion. En este paso se vuelca la informacion sobre el dispositivo y se comprueba
el funcionamiento de forma experimental.
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Parte 1: Estudio tedrico

El objetivo es disefiar un circuito secuencial que cuente de forma ascendente en formato BCD y
que muestre la cuenta en un display 7 segmentos. El disefio constara de dos circuitos:

e Un contador BCD

e Un convertidor de cddigo de BCD a 7-segmentos.
Para el contador BCD se va a utilizar una celda de libreria (CD4RE), pero el decodificador BCD
a 7-segmentos vamos a construirlo.

Disefie un convertidor de BCD a 7-segmentos. Siga los siguientes pasos, escribiéndolos en hojas
aparte:
e Dibuje la tabla de verdad del circuito. Para ello tenga en cuenta que cada segmento
del display se enciende cuando hay un ‘0’ en su entrada.
e Disénelo utilizando un decodificador de 4 a 16 (con salidas activas en alta) y puertas
OR. Debe saber que cada salida del decodificador se corresponde con un mintérmino
de la funcion. Una a cada puerta OR los mintérminos correspondientes al segmento
que ha de encenderse.

El componente CD4RE es un contador BCD de4 bits con clock enable y reset sincrono:

e Dibuje un cronograma en el que se aprecie el funcionamiento del contador sabiendo
que su tabla de funcionamiento es la siguiente:

Inputs QOutputs

R CE |[C |1Q3 Q2 Q1 Qo0 TC | CEO
1 X 1 0 0 0 0 0 0

0 1 1 Inc Inc Inc Inc TC | CEO
0 0 X | No change | No change | Nochange | Nochange | TC |0

0 1 X 1 0 0 1 1 1

TC =Q3*!Q2*!Q1*Q0

CEO =TC*CE
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Parte 2: Estudio Experimental

Introduccién del disefio del convertidor de cédigo

El primer paso consiste en introducir el disefio. Para ello se siguen los siguientes pasos:

N
—

5.2

5.3.

5.4.

Arranque el entorno de diseno haciendo doble clic sobre el icono del escritorio: “ISE Design
Suite 14.7”.

Crear un nuevo proyecto (en esta herramienta los disefios se agrupan dentro de “proyectos”):

File -> New Project...
En la ventana que aparece se rellena la siguiente informacion:

Project Name: <nombre del alumno> (No introducir espacios ni acentos niii)

Project Location: c:\ED

Top-Level Module Type: Schematic

Se pulsa el boton “siguiente”. En la ventana que aparece nos aseguramos de introducir la
siguiente informacion:

Device Family: Spartan 3E

Device: XC3S100E

Package: CP132

Speed Grade: -4

Generated Simulation Language: VHDL

Pulsamos “next” y después “Finish”.
Se nos abre la ventana principal del software.

Una vez creado el proyecto lo primero que tenemos que hacer es afiadir un disefio nuevo. En
primer lugar vamos a crear el convertidor de BCD a 7-segmentos. Para ello ejecutamos el
comando:

Proyect -> New Source...

En la parte izquierda seleccionamos “Schematic” y en la derecha le damos nombre:

File Name: decTseg

Presionamos “siguiente” y “finalizar”.

También puede hacerse colocando el raton encima del nombre del proyecto, y presionando el
botén derecho. Se nos abre un menu en el que escogemos la opcidn “New Source "

Tras crear el disefio, se nos abre automaticamente la ventana de captura de esquemas.
Los comandos basicos dentro de este entorno son (recordatorio):

« Para colocar una puerta logica: Add -> symbol

(se selecciona en la seccion “symbol™ que aparece a la izquierda)

« Para dibujar una conexion entre dos puertas: Add -> wire

Para poner una conexion de entrada o salida: Add -> I/0 Marker
(se coloca automaticamente de entrada o de salida)
Para salvar el disefio: File -> Save
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+ Nombrar una linea de conexion (wire): picar dos veces sobre el cable y poner el nombre en

la ventana que se abre.

= Para hacer un zoom sobre una zona: pulsar F9 y hacer un rectangulo en la zona a visualizar.
= Para ver todo el disefio: pulsar F6.
+ Para dejar de aplicar un comando: presionar la tecla “Escape”.

[Los componentes a utilizar para la realizacion del disefo son:

55.

Elemento Calegoria Simholo
Decodificador 4 a 16 Decoder d4_l6e
Puerta OR de 2 entradas Logic or2
Puerta OR de 3 entradas Logic or3
Puerta OR. de 4 entradas Logic ord
Puerta OR. de 6 entradas Logic orb
Tensién a *17 lgico General vee

Colocamos e interconectamos todos los componentes. En la entrada “E™ del decodificador
colocamos un ‘1’ légico con el elemento “vdd”. Ponemos ademas un IO Marker en cada
entrada y salida. Nos aseguramos que tienen la polaridad correcta (entrada o salida) v le
cambiamos los nombres (les ponemos unos que nos aporten informacion). El cambio de
nombres se hace en la ventana que aparece tras picar dos veces sobre el “I/O Marker”.

Reahizamos una simulacién funcional sigmiendo los siguientes pasos:

5.6.

5.7.

Anadimos una nueva “source” que contenga los patrones de simulacion. Para ello ponemos el
raton sobre el nombre del componente “dec7seg”, presionamos el boton derecho del raton y en
el menu que aparece seleccionamos “New Source...”.

En la ventana que aparece seleccionamos en la 1izquierda “VHDL Test Bench” y como nombre
de fichero introducimos: “tb_dec7seg”. Presionamos “next” y como Associate Source
seleccionamos “dec7seg”. Presionamos “next” y “finish”.

Introducimos los patrones de simulacion.
Esto nos abre un fichero de texto (un test_bench en VHDL) en el que hay que mtroducir los
patrones de simulacion. Modifique el fichero para que quede de la siguiente forma:

-— **% Test Bench - User Defined Section ***
tbh : PROCESS

variable i: unsigned(3 downto 0) := "0000";
BEGIN

wait for 30 ns;

i =1+ 1;

al <= 1(0);
al <= i(1);
a2 <= 1i(2);
ald <= 1i(3});

END PROCESS;
-- **% End Test Bench - User Defined Section ***
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5.8.  Salvamos el fichero.

5.9. Arrancamos el simulador
Una vez salvado los patrones de simulacion, presionamos en la zona “View” (parte superior
izquierda) sobre “simulation”, después seleccionamos el diseiio (tb_cto_secuencial) y
finalmente arrancamos el simulador picando dos veces sobre “Simulate Behavioral Model”.
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5.10. El simulador automaticamente muestra las entradas y salidas. Para ver todos los patrones
ponga el cursor sobre la ventana “Waves” y presione Fo6.
Compruebe que la simulacion produce los resultados esperados.
Finalmente avise al profesor para que lo compruebe.

5.11. Una vez comprobado por el profesor puede cerrar el simulador.

5.12. Una vez comprobado el correcto funcionamiento del circuito le creamos un simbolo. Para ello
seleccionamos la vista “Implementation” (parte superior izquierda), seleccionamos el
componente “dec7seg” y en la parte de “Processes” en la zona de “Design Utilities”
ejecutamos “Create Schematic Symbol”.

6. Introduccion del disefio completo

6.1. Creamos un segundo componente al que llamaremos “contador modulol0”. Para ello
seguimos los pasos:
Proyect -> New Source...
En la parte izquierda seleccionamos “Schematic” y en la derecha le damos nombre:
File Name: contader module 10
Presionamos “siguiente” ¥ “finalizar' .
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6.4.

6.5.
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Introducimos el esquematico. Los componentes a instanciar son tres:
Elemento Categoria Simbolo
Contador BCD Counter cddre
Convertidor BCD a 7 segmentos decTseg
Buffer Buffer bufg

NOTA: Para que funcione la sefal de reloj en pin que no es de reloj hay que colocar dos
buffers, un “bufg” tal como se muestra en la figura:

Colocamos los dos componentes principales y los interconectamos. Finalmente les ponemos
los 1/0 Makers en las entradas y salidas y les ponemos nombres. El display 7 segmento tiene
una seial de activacion. Esta seial la activaremos con un conmutador. Como no se puede
conectar directamente una entrada a una salida ponemos un buffer.

Una vez terminado el disefio lo salvamos.

Sobre este circuito se realizard simulacion solo si hay tiempo. Se seguirdn los pasos seguidos
anteriormente.

Una vez terminado el disefio generamos un fichero de restricciones en el que decimos la
localizacion de las entradas y las salidas. Las entradas las vamos a conectar a conmutadores y a
un pulsador vy las salidas al display 7 segmentos. La localizacion de dichos pines es:

Conmutadores de entrada LEDs
nombre posicion segmento posicion
SWO (reset) P11 a L14
SW1 (ce) L3 b HI12
SW2 (enable) K3 c N14
BTNO (clk) Gl2 d NI
€ Pl2
f L13
g M12
ANO {enable display) | F12

Esto se hace de la siguiente forma:

6.6.

Colocamos el raton sobre el disefio y afiadimos una nueva fuente que esta vez es del tipo
“Implementation Constraint File”. Este fichero lo asociamos al disefio “contador_modulo_10".
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Esto crea una unidad llamada contador_modulo_10.ucf. Se nos abre el fichero para poner las
restricciones. Lo rellenamos de la siguiente forma:

NET
NET
NET
NET

NET
NET
NET
NET
NET
NET
NET

NET
NET

"CE" LOC = L3;
"olk" LOC = G1l2;
"enable" LOC = K3;
"reset" LOC = P11;
"a" LOC = L14;

"kh" LOC = H1Z;

"o LOC = M14;

"d" LOoC = WNll;

"e" LOC = PlZ;

"f" LOC = L13;

"g" LOC = M12;
“"enable 0" LOC = F12;

"clk" CLOCK_DEDICATED ROUTE = FALSE;

6.7. Una vez introducidos los datos salvamos y cerramos la ventana.

Nos aseguraremos que todos los pasos se han realizado correctamente realizando la implementacion
del circuito. Para ello:

6.8. Nos aseguramos de que en la ventana “Sources in Project” esta seleccionado el disefio que se
esta realizando.

6.9.

En la ventana “Processes for Source” nos posicionamos sobre “Generating Programming File

L2

y pulsando el boton de la derecha, en el meni que aparece, seleccionamos “Process
Properties”.
En la ventana que aparece, en la categoria “Startup Options” ponemos la variable “FPGA

Start-up Clock™ a “JTAG Clock™.

e

St e | aosty e vaw

Garvwl Conore
Canfigraer Cpbeee
Sates Cptions

Poabid optyes

-3 Daneioe

S AutpIc | FGA sty Cock
Laatie Intenal Core Ppe

e Do Ot Everts)

Erathy Oz (OUD Evmols)

1 one ese e by e

Bropty desny vl (avin: w] 5 Onginy Sebh rames

—]

Cand I ey

s foetaat (i
it TN

-

Rl

e |

Una vez cambiado seleccionamos “Run” en Generation Programming File. Si todo termina
correctamente podemos seguir adelante. En caso contrario hay que corregir los errores.

7.  Programacion del dispositivo y comprobacién del funcionamiento

El proceso de programacion del dispositivo tiene el siguiente orden de pasos:
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7.1.  En primer lugar se conecta la placa al PC mediante el cable USB.
NOTA: La placa se coge por los bordes. No se tocan los componentes de la parte superior ni de
la parte inferior.

7.2, Se arranca el software de programacion:
Inicio -> Programas -> Digilent -> Adept -> Adept
A Digitent Adept - 8 ot 1
BASYS 2) ot ooz K|
Froduct: Basys2 - 100
Config | Test | Register I/0 | File YO | VO Ex | Setings |
[ Y p—
I o I |

[Bowd nfcenaticn Gaded. 5|
Found 1D 15045096

Fourd device 1D; 1110083

Tnitakzation

Devie 1} KCE10E
Dwvics 2: XCFO2S :I
>

[
En esta ventana se reconocen los dos dispositivos que hay en la placa: la FPGA y una memoria
PROM. Nosotros vamos a programar la FPGA. Buscamos el fichero .bit que ha creado el
software de Xilinx, y pulsamos “Program”.

7.3. Finalmente avise al profesor para que compruebe el funcionamiento.



